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18.1 அறிமுகம்

“ பிறநாட்டு நல்லறிஞர் சாத்திரங்கள்

தமிழ்மொழியிற் பெயர்த்தல் வேண்டும்; 

இறவாத புகழுடைய புதுநூல்கள் 

தமிழ்மொழியில் இயற்றல் வேண்டும்; 

மறைவாக நமக்குள்ளே பழங்கதைகள் 

ச�ொல்வதில�ோர் மகிமை இல்லை; 

திறமான புலமையெனில் வெளிநாட்டோர்; 

அதை வணக்கஞ் செய்தல் வேண்டும்.”

-  மகாகவி பாரதி

	 இருபதாம் நூற்றாண்டின் இணையற்ற 

மனித கண்டுபிடிப்புதான் கணிப்பொறி. த�ொடக்க 

காலத்தில் கணக்கிடும் கருவியாக த�ொடங்கிய 

கணிப்பொறியின் வளர்ச்சி இன்று கணிப்பொறி 

இல்லாமல் மனித வாழ்வு இல்லை என்ற நிலையில் 

தனது அசுர வளர்ச்சியால் மனிதர்களின் 

அத்தியாவசிய ப�ொருளாக மாறிவிட்டது. 

	 மாறிவரும் த�ொழில்நுட்பங்களுக்கு 

ஈடுக�ொடுத்து தன்னை தகவமைத்துக்கொள்ளும் 

ஆற்றல் எந்த ம�ொழிக்கு இல்லைய�ோ அந்த ம�ொழி 

கால வெள்ளத்தில் அடித்து செல்லப்பட்டுவிடும் 

என்பது உண்மை. எத்தனை புதிய 

த�ொழில்நுட்பங்கள் வந்தாலும் அவை 

அனைத்தையும் தன்வயப்படுத்திக்கொண்டு 

தன்னிலை மாறாது, வாழும் ம�ொழியாக பல 

ஆயிரம் ஆண்டுகளாக வாழ்ந்து வருவது நமது 

செந்தமிழ். தமிழ் வெறும் ம�ொழியல்ல, நமது 

அடையாளம், நமது உயிர், நமது உணர்வு.

“எங்கள் வாழ்வும், எங்கள் வளமும் மங்காத 

தமிழென்று சங்கே முழங்கு” – புரட்சி கவி.

பாடம் 18
கணிப்பொறியில் தமிழ்

அலகு V கணிப்பொறியில் தமிழ்

	 இயல், இசை, நாடகம் எனும் முத்தமிழ் 

இன்று கணினித்தமிழ் என “நான்தமிழ்” (நான்கு + 

தமிழ்) என்றாகி தமிழ்த்தாயின் முடியில் மேலும் ஓர் 

அணியாய் திகழ்கின்றது. கணிப்பொறியில் தமிழின் 

நிலை அதன் எதிர்காலம் பற்றி இனி காணாலாம்.

18.2 இணையத்தில் தமிழ்:

	 இணையம்  இன்று  ஒவ்வொரு  சாதாரண  

மனிதனின் வாழ்விலும் பிரிக்கவியலா ஓர் 

அங்கமாகிவிட்டதை நாம் அறிவ�ோம். இணையம் 

மிகச்சிறந்த தகவல் த�ொழில்நுட்ப சாதனம்.  

இணையத்தின் மூலம் நாம் அனைத்தையும் 

தெரிந்துக�ொள்ளலாம். 

	 சிங்கப்பூர்-யை தலைமையிடமாக்க 

க�ொண்ட KPMG என்ற நிறுவனம் கூகுளு-டன் 

இணைந்து கடந்த ஆகஸ்டு 2017-ல் நடத்திய 

ஆய்வில், 2016ம் ஆண்டுவாக்கில் இந்தியாவில் 

இணையத்தில் அதிகமாக பயன்படும் ம�ொழிகளில் 

தமிழ் முதலிடம் வகிப்பதாகவும், 42% பேர் தமிழ் 

மூலம் இணையத்தை பயன்படுத்துவதாகவும் 

தெரிவித்துள்ளது. 

	மே லும், 2021ம் ஆண்டுவாக்கில், 74% பேர் 

தமிழில் இணையத்தை அணுகுவார்கள் என்றும் 

அப்போதும், இந்தியாவில் இணையத்தில் தமிழே 

முதலிடத்தில் இருக்கும் எனவும் 

தெரிவிக்கப்பட்டுள்ளது. 
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இந்த புள்ளிவிவர கணக்குகள் மேலும் பல இணைய சேவைகளை தமிழில் வழங்க உதவும்.

18.3 தமிழில் தேடுப�ொறிகள்:

	 இணையம் என்ற அகன்ற வெளியில், 
உங்களுக்கு தேவையான தகவல்களை 
ந�ொடிப்பொழுதில் தேடித்தருபவை 
“தேடுப�ொறிகள்”. பல தேடுப�ொறிகள் இருந்தாலும், 
அவற்றில் சிறந்து விளங்குபவை ஒரு சில மட்டுமே. 
இணைய உலகில் சிறந்த பத்து தேடுப�ொறிகளில், 
“கூகுள் (Google)” முதலிடத்திலும், 
மைக்ரோசாஃப்ட் நிறுவனத்தின் “பிங் (Bing)” 
இரண்டாம் இடத்திலும், “யாகூ (Yahoo)” 
மூன்றாமிடத்திலும் உள்ளது. இதில், கூகுள் 
மற்றும் பிங் தமிழில் தேடும் சேவைகளை வழங்கி 
வருகின்றது. கூகுள் தமிழில் தேடுவதற்கு 
வசதியாக, தமிழ் தட்டச்சு வசதியையும் 
வழங்குகின்றது. 

உள்ளீட்டுக் கருவிகள்

படம் 18.1(a) தமிழில் கூகுள் (இந்தியா)

உள்ளீட்டுக் கருவிகள்

படம்  18.1(b) தமிழில் கூகுள் (சிங்கப்பூர் மற்றும் 

மலேசியா)

படம்  18.2 கூகுளில் தமிழில் தேடுதல்

18.4 மின் அரசாண்மை (e-Governance):

	 ஒரு அரசின் சேவைகளை இணையத்தின் 
வழியே பெறுவது மின் அரசாண்மை எனப்படும். 
நமது தமிழ்நாடு அரசு தனது அனைத்து 
சேவைகளையும் இணையத்தின் வழியே வழங்கி 
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வருகின்றது. தமிழகத்தின் எந்த மூலையில் 
இருந்தாலும், அரசுடன் உடனடியாக 
இணையத்தின் வழியே த�ொடர்பு க�ொள்ள முடியும். 
முக்கிய அறிவிப்புகள், அரசாணைகள், அரசின் 
திட்டங்கள், சேவைகள் ப�ோன்றவை 
இணையத்தின் வழியே கிடைக்கின்றது. 

படம்  18.3 தமிழக அரசின் இணையதளம்

தமிழ் வழி மின் 
அரசாண்மை

இணைய முகவரி

தமிழ்நாடு அரசு 
அதிகாரப்பூர்வ 
இணையதளம்

http://www.tn.gov.in/ta

வேளாண்மை ப�ொறியியல் 
துறை

http://www.aed.tn.gov.in/ 

தமிழ்நாடு அரசு சுற்று 
சூழல் துறை

http://www.environment.
tn.nic.in/ 

அரசு தேர்வுகள் துறை http://www.dge.tn.nic.in/ 
தமிழ்நாடு சுகாதாரத் 
துறை

http://www.tnhealth.org/ 

தமிழ்நாடு சிறு, குறு 
த�ொழில் முனைவ�ோர் 
நலத்துறை

http://www.msmeonline.
tn.gov.in/ 

ஊரக வளர்ச்சி மற்றும் 
ஊராட்சித் துறை

http://www.tnrd.gov.in/ 

பிற்படுத்தப்பட்டோர், 
மிகவும் 
பிறபடுத்தப்பட்டோர் 
மற்றும் சிறுபான்மையினர் 
நலத்துறை

http://www.bcmbcmw.
tn.gov.in/ 

தமிழ்நாடு அரசு 
வனத்துறை

https://www.forests.
tn.gov.in/ 

இந்து அறநிலையத் துறை http://www.tnhrce.org/ 
தமிழ்நாடு அரசு 
பணியாளர் 
தேர்வாணையம் (TNPSC)

http://www.tnpsc.gov.in/
tamilversion/index.html 

இலங்கை அரசின் 
அதிகாரப்பூர்வ 
இணையதளம்

https://www.gov.lk/index.
php 

	 இந்தியாவிற்கு வெளியே, இலங்கை அரசு 
தனது இணைய சேவை முழுவதும் தமிழில் 
வழங்குகிறது. சிங்கப்பூர் அரசு தனது 
அதிகாரப்பூர்வ இணைய தளத்தை தமிழில் 
இயக்கவில்லை எனினும், அனைத்து அரசு 
சேவைகளை, தமிழிலும் வழங்கி வருகின்றது

18.5 மின் நூலகம்:

	 மின்நூல்களை (e-Books) த�ொகுத்து 
வழங்குபவை மின் நூலகங்கள், லட்சக்கணக்கான 
தமிழ்நூல்களைக் க�ொண்ட மின்நூலகங்கள் பல 
நிறுவப்பட்டுள்ளது. இவை, இணையத்தின் வழியே 
அச்சு புத்தகங்கள் ப�ோய் சேரமுடியாத இடங்களில் 
வாழும் ஆயிரக்கணக்கான தமிழர்களுக்கு நல்ல 
பல தமிழ்நூல்களை க�ொண்டு சேர்க்கும் 
பணியினை செய்து வருகின்றன.

மின் நூல்கள் 
கிடைக்கும் தளங்கள்

இணைய முகவரிகள்

ஒன்றாம் வகுப்பு முதல் 
12 ம் வகுப்பு வரையான 
தமிழ்நாடு மாநில பள்ளி 
பாடப்புத்தகங்களும், 
இடைநிலை ஆசிரியர் 
பயிற்சி 
பாடப்புத்தகங்களும்

http://www.
textbooksonline.
tn.nic.in/ 

தமிழ்நாடு இணைய 
கல்விக் கழக மின் 
நூலகம்
(முன்னர் தமிழ்நாடு 
இணையப் பல்கலைக் 
கழகம் என 
அழைக்கப்பட்டது)

http://www.tamilvu.
org/library/libindex.
htm 

கன்னிமரா மின் 
நூலகம்

http://
connemarapublic 
librarychennai.com 
/Veettukku_oru_
noolagam 
/index.html

தமிழிணைய 
மின்னூலகம்

http://
tamildigitallibrary.in/ 

சென்னை நூலகம் http://www.
chennailibrary.com/ 
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தமிழகம்
http://www.
thamizhagam.net/
parithi/parithi.html 

மதுரை தமிழ் இலக்கிய 
மின் த�ொகுப்புத் திட்டம்

http://www.
projectmadurai.org/
pmworks.html 

பழமையான 
புத்தகங்கள் மற்றும் 
கையெழுத்துப் 
பிரதிகள்

http://www.
tamilheritage.org/old/
text/ebook/ebook.
html 

நூலகம்
http://www.
noolaham.org/wiki/
index.php/ 

அண்ணா நூற்றாண்டு 
நூலகம்

http://www.
annacentenarylibrary.
org/ 

18.6  தமிழ் தட்டச்சு இடைமுக மென்பொருள்

	 கணிப்பொறியை பயன்படுத்தி 
ச�ொற்செயலிகளில் ஆவணங்களை தட்டச்சு 
செய்யவும், இணையத்தின் வழியே தகவல்களை 
தேடவும், பெறவும் மட்டுமே தமிழ் அதிகமாக 
பயன்படுத்தப்படுகிறது. கணிப்பொறியில் தமிழில் 
தட்டச்சு செய்ய பல்வேறு வழிமுறைகள் 
பயன்படுத்தப்படுகிறது. அவற்றில், தமிழ் இடைமுக 
மென்பொருட்களை பயன்படுத்தி  தட்டச்சு செய்யும் 
முறை தற்போது மிகவும் பிரபலமான ஒன்றாகும். 
கணிப்பொறிகள் மட்டுமின்றி ஸ்மார்ட் 
கைப்பேசிகளிலும், இம்முறையில் தட்டச்சு 
செய்வது மிகவும் எளிதான ஒன்றாகும். 

18.6.1 பிரபலமான தமிழ் இடைமுக 
விசைப்பலகைகள்:

•	 NHM Writer, e-கலப்பை மற்றும் லிப்பிகார் – 
ப�ோன்றவை ஆங்கில ஒலியியல் முறையில், 
தமிழ் யுனிக�ோட், தமிழ் 99 ப�ோன்ற தட்டச்சு 
முறையில் வேலை செய்யும் தமிழ் விசைப் 
பலகை இடைமுக மென்பொருட்கள் ஆகும்.

•	 செல்லினம் மற்றும் ப�ொன்மடல் – ஸ்மார்ட் 
கைப்பேசிகளில், ஆண்ட்ராய்டு இயக்க 
அமைப்பில், ஆங்கில ஒலியியல் முறையில் 
பயன்படுத்தப்படும் இடைமுக விசைப்பலகை 
மென்பொருட்கள் ஆகும்.

படம்  18.4 eKalappai த�ொடக்க திரை

18.7 தமிழ் அலுவலக மென்பொருட்கள்

	 பிரபலமான அலுவலக 
மென்பொருட்களான மைக்ரோசாப்ட் ஆஃபீஸ், 
ஒபன் ஆஃபீஸ் ப�ோன்றவை தமிழில் பயன்படுத்தும் 
வகையில் தமிழ் இடைமுக வசதியை வழங்குகிறது. 
இவ்வசதிகளை இணையத்தின் வழியே 
பதிவிறக்கம் செய்து, நிறுவிக் க�ொள்ள முடியும். 
தமிழ் இடைமுகம் நிறுவப்பெற்ற பின்னர், அலுவலக 
மென்பொருட்களின் (மைக்ரோசாப்ட் ஆஃபீஸ், 
ஒபன் ஆஃபீஸ்) பட்டிப்பட்டை, குறும்படங்களின் 
பெயர்கள் ப�ோன்ற அனைத்தும் தமிழில் 
த�ோன்றும். மேலும், க�ோப்புகள் மற்றும் 
க�ோப்புரைகளின் பெயர்களை தமிழிலேயே 
உருவாக்க முடியும். 

படம் 18.5 Libra Office Writer தமிழ் பதிப்பு

	 இவை மட்டுமின்றி, முழுவதும் தமிழிலேயே 
இயங்கும் அலுவலக மென்பொருட்களும் 
பயன்பாட்டில் உள்ளது. அவற்றில் தமிழ் லிபரெ 
ஆஃபீஸ், தமிழ் ஒபன் ஆஃபீஸ், அழகி யுனிக�ோட் 
எடிட்டர், ப�ொன்மொழி, மென்தமிழ், கம்பன், வாணி 
ப�ோன்ற அலுவலக மென்பொருட்கள் முழுவதும் 
தமிழில் பயன்படுத்தும் வகையில் 
வடிவமைக்கப்பட்டுள்ளது. 

18.8 தமிழ் ம�ொழிபெயர்ப்பு பயன்பாடுகள்:

	 ”தமிழ்பொறி” என்ற மென்பொருள், சுமார் 
30000 க்கும் அதிகமான ஆங்கில ச�ொற்களுக்கு 
ஈடான தமிழ் ச�ொற்களை உள்ளடக்கிது. இதன் 
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மூலம், சிறிய ஆங்கில ச�ொற்றொடர்களுக்கு 
இணையான தமிழ் ம�ொழி பெயர்ப்பை பெறலாம். 

	 மேலும், கூகுள் நிறுவனம், தமிழிலிருந்து 
பிற ம�ொழிகளுக்கு ம�ொழி பெயர்க்கும் 
“ம�ொழிபெயர்ப்பு” நிகழ்நேர பயன்பாட்டை 
வழங்கிவருகின்றது.

18.9 தமிழ் நிரலாக்க ம�ொழி:

	 கணிப்பொறி மற்றும் ஸ்மார்ட் 
கைப்பேசிகளில் மென்பொருட்களை வடிவமைக்க 
பயன்படும் நிரலாக்க ம�ொழிகள் இதுவரை 
ஆங்கிலத்தில் மட்டுமே இருந்துவந்த நிலையில், 
தமிழிலும், நிரலாக்க ம�ொழி வடிவமைக்கும் 
முயற்சிகள் நடைபெற்றுவருகின்றன. 
அதனடிப்படையில், பைத்தான் நிரலாக்க 
ம�ொழியை அடிப்படையாக க�ொண்டு, முதல் தமிழ் 
நிரலாக்க ம�ொழி “எழில்” வடிவகைக்கப்பட்டுள்ளது. 
இந்த நிரலாக்க ம�ொழியை பயன்படுத்தி, சிறிய 
அளவிலான நிரல்களை தமிழிலேயே எழுதமுடியும். 

தமிழ் தகவல் பரிமாற்றத்திற்கான குறியீட்டு 
முறைகள்

18.10 தகவல் பரிமாற்றத்திற்கான தமிழ் 
குறியீட்டு முறை

TSCII (Tamil Script Code for Information 
Interchange) 

	 கணிப்பொறி இருநிலை எண்களை 
அடிப்படையாக க�ொண்டது எனவும், 
கணிப்பொறியில் உள்ளிடப்படும் தரவுகள் இருநிலை 
எண்களாக மாற்றப்படும் என்பதையும், இந்த பாடப் 
புத்தகத்தின் முதல் அலகில் கற்றீர்கள். 
கணிப்பொறியில் க�ொடுக்கப்படும் தரவுகளும், 
தகவல்களும் கையாள ASCII என்ற குறியீட்டு 
முறை பயன்படுத்தப்பட்டுவந்தது. இந்த குறியீட்டு 
முறை ஆங்கில ம�ொழியை மட்டுமே கையாளும் 
திறன் பெற்றது. எனவே, ஆங்கிலம் அல்லாத பிற 
ம�ொழிகளை கணிப்பொறி உள்ளிட்ட மின்னணு 
சாதனங்களில் எளிதில் கையாள ப�ொருத்தமான 
ஒரு குறியீட்டு முறை பற்றிய ஆய்வில், நமது தமிழ் 
ம�ொழியை கையாள உருவாக்கப்பட்ட முதல் 
குறியீட்டு முறை தான் TSCII (Tamil Script Code 
for Information Interchange) என்பதாகும். இந்த 
குறியீட்டு முறை 2007ம் ஆண்டில், ICANN-ன் 
IANA (Internet Assigned Numbers Authority)
யில் பதிவு செய்யப்பட்டது. இந்த குறியீட்டு முறை 
தழுவியே தமிழுக்கான Unicode முறையும் 
வடிவமைக்கப்பட்டது. 

தகவல் பரிமாற்றத்திற்கான இந்திய குறியீட்டு முறை

ISCII (Indian Script Code for Information 
Interchange) 
	 இந்திய ம�ொழிகளை கையாளுவதற்காக 
வடிவமைக்கப்பட்ட ஒரு குறியீட்டு முறை. இந்த 
முறையை, ஒருங்குறி முறையுடன் 
இணைக்கப்பட்டுவிட்டது. 

ஒருங்குறி  Unicode:
	 தமிழ் உள்ளிட்ட பல்வேறு உலக 
ம�ொழிகளை கையாளுவதற்காக 
வடிவமைக்கப்பட்ட ஒரு குறியீட்டு முறை தான் 
ஒருங்குறி என்று அழைக்கப்படும் யுனிக�ோட். 
இதன் முதல் பதிப்பான யுனிக�ோட் 1.0.0 என்பது 
அக்டோபர் 1991ல் அறிமுகப்படுத்தப்பட்டது. 
அறிமுகப்படுத்தப்பட்ட ப�ோது, தமிழ் உள்ளிட்ட 23 
ம�ொழிகளை கையாளும் திறன் பெற்றிருந்தது. 
தமிழை கையாள பல குறியீட்டு முறைகள் 
இருப்பினும், இன்று ஒருங்குறியே சிறந்த ஒன்றாக 
திகழ்கிறது.

18.11  தமிழ் இயக்க அமைப்புகள் 

	 கணிப்பொறி அல்லது ஸ்மார்ட் கைப்பேசி 
ப�ோன்ற மின்னணு சாதனங்களை இயக்க 
ஏதேனும் ஒரு இயக்க அமைப்பு வேண்டும். 
தனியாள் கணிப்பொறிகளில் மிகப்பிரலமான 
இயக்க அமைப்பு மைக்ரோசாப் நிறுவனத்தின், 
விண்டோஸ் ஆகும். விண்டோஸ் இயக்க 
அமைப்புக்கு அடுத்த இடத்தில், திறந்த மூல 
இயக்க அமைப்பான லினக்ஸ் உள்ளது. 

	 ஒரு கணிப்பொறியை எளிதில் இயக்க 
இயக்க அமைப்பு பயன்படுகிறது. ஒரு இயக்க 
அமைப்பு பயன்படுத்துவதற்கு எளிதாகவும், 
பயன்படுத்துவ�ோர் புரிந்துக�ொள்ளும் வகையிலும் 
அமைக்கப்பட்டிருக்க வேண்டும் என்ற வகையில், 
கணிப்பொறியில் பயன்படுத்தப்படும் விண்டோஸ், 
லினக்ஸ் ப�ோன்ற இயக்க அமைப்புகளையும், 
ஸ்மார்ட் ப�ோன்களில் பரவலாக பயன்படுத்தப்படும் 
ஆண்டிராய்டு இயக்க அமைப்பும் தமிழ் ம�ொயில் 
வழங்கப்பட்டுள்ளது. 

	 விண்டோஸ் இயக்க அமைப்பின் 
பணிப்பட்டை, திரை முகப்பு, பணிக்குறிகள், 
கட்டளைகள் அனைத்தும் தமிழிலேயே காணக் 
கிடைக்கும். விண்டோஸ்-ன் தமிழ் இடைமுக வசதி, 
மைக்ரோசாப்ட் நிறுவனத்தின் 
இணையதளத்திலிருந்து பதிவிறக்கம் செய்து, 
நிறுவிக்கொள்ளலாம்.
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18.12 தமிழ் வளர்க்கும் நிறுவனங்களும், 
திட்டங்களும்:

தமிழ் இணையக் கல்விக்கழகம்:

	 தமிழை உலகெங்கிலும் இணையத்தின் 
வழியே க�ொண்டு சேர்க்கும் ந�ோக்குடன், 2001ம் 
ஆண்டு பிப்ரவரி மாதம் 17ம் நாளில், தமிழ் இணையப் 
பல்கலைக் கழகம், தமிழக அரசால் 
த�ொடங்கப்பட்டது. தற்போது தமிழ் இணையக் 
கல்விக் கழகம் என்ற பெரியில் செயல்பட்டு வரும் 
இந்நிறுவனம் இணையத்தின் வழியை தமிழ் ம�ொழி, 
தமிழர் கலாச்சாரம், பண்பாடு ப�ோன்றவை 
உலகெங்கிலும் வாழும் மக்களுக்கு 
வழங்குவதற்காக, மழலையர் கல்வி முதல் பட்டப் 
படிப்பு வரை பல்வேறு கல்வித் திட்டங்களை 
செயல்படுத்தி வருகின்றது.
இணைய முகவரி:  http://www.tamilvu.org/
index.php
வளர் தமிழ் இயக்கம், சிங்கப்பூர்
	 சிங்கப்பூரில் தமிழ்மொழியை வாழும் 
ம�ொழியாகவும் பயன்பாட்டு ம�ொழியாகவும் 
நிலைபெறச் செய்வத�ோடு, அனைத்து 
வயதினரையும் தமிழால் ஒன்றிணைத்து, 
சிங்கப்பூரில் தமிழ்மொழியை ஓங்கச் செய்யும் 
ந�ோக்கத்துடன் 2001ம் ஆண்டில், சிங்கப்பூர் 
தகவல் கலை அமைச்சகத்தின் மேற்பார்வையில் 
இந்த இயக்கம் த�ொடங்கப்பட்டது.
இணைய முகவரி:   http://tamil.org.sg/ta
மதுரை தமிழ் இலக்கிய மின் த�ொகுப்புத் திட்டம்:
	 தமிழில் உள்ள அனைத்து நூல்களையும், 
இணையத்தில் மின்னணு வடிவில் 
வெளியிடுவதற்கான ஒரு தன்னார்வ அரசு சாரா 
திட்டம் ஆகும். அதாவது தட்டச்சு செய்தல், பழைய 
புத்தகங்களை ஸ்கேன் செய்தல் மற்றும் 
அணைத்து பிரபலமான கணினிகளிளும் 

பயன்படுத்துவதறகாக 
எளிதில் அணுகக்கூடிய 
வடிவங்கள் ஒன்றில் 
உரையை காப்பகப்படுத்துதல் 
ப�ோன்றவை ஆகும். 
இத்திட்டத்தின் மூலம் 1998ம் ஆண்டு முதல், இது 
வரை தமிழில் வெளிவந்துள்ள அனைத்து 
நூல்களையும் இணையத்தில் ஏற்றும் பணிகள் 
மேற்கொள்ளப்படுகிறது. 2004 முதல் தமிழ் 
ஒருங்குறியிலும் இணைய புத்தகங்கள் 
வெளியிடுவது த�ொடங்கப் பட்டது. உலகெங்கிலும் 
வாழும் தமிழர்களின் தன்னலமற்ற முயற்சியால் 
இத்திட்டத்தில் இதுவரை பல  நூல்கள் இணைய 
வெளியில் பதிவேற்றம் செய்யப்பட்டுள்ளது. 
இணைய முகவரி: http://www.projectmadurai.org/
தமிழ் விக்கிபீடியா:
	 விக்கிபீடியா ஒரு திறந்த நிலை 
களஞ்சியமாகும். விக்கிபீடியாவில் எவரும், எந்த 
தலைப்பிலும் கட்டுரைகளை எழுதலாம். தமிழ் 
விக்கிபீடியா தமிழில் ஒரு இலட்சத்திற்கும் 
மேலான கட்டுரைகளை உள்ளடக்கிய ஒரு மிகப் 
பெரிய கலைக் களஞ்சியமாகும். 
இணைய முகவரி:  Web Site: https://
t a . w i k i p e d i a . o r g /
	 தமிழை, வாழும் ம�ொழியாக்க 
வேண்டுமெனில், த�ொழில்நுட்பத்தில் வளர்ச்சியில், 
தமிழை பங்குபெற செய்ய வேண்டியது தமிழராகிய 
நமது கடமை. தனது இனத்தின் மதிப்புகளை  
மறந்தவர், "ந�ோமட்ஸ்" (no mades) நாம் எத்தனை 
பெரிய த�ொழிநுட்பங்களை கற்றாலும், அதனுள் 
நமது இனத்தின் அடையாளமான தமிழை 
க�ொண்டு சேர்க்க வேண்டும். உலகின் முதல் 
ம�ொழி, மூத்த ம�ொழி ஐந்தாயிரம் ஆண்டுகளுக்கும் 
மேலாக இன்றைக்கும் வாழும் ம�ொழியை, கணினி 
த�ொழில்நுட்பத்துடன் இணைப்பது நமது கடமை.

•	 இந்தியாவில் 2016 ஆம் ஆண்டு இறுதியுடன், தமிழ் ம�ொழி முதன்மையான பட்டியலுடன் விளங்கி, இணையம் 42 
விழுக்காடு பயன்படுத்துகின்றனர்.

•	 தமிழில் தேடுதல் வசதிகளை கூகுள் (Google)  மற்றும் பிங் (Bing)  அளிக்கின்றன.
•	 இணையத்தின் மூலமாக அரசு சேவைகளைப் பெற இ-சேவை வழங்குகின்றன.
•	 ஆயிரக்கணக்கான தமிழ் புத்தகங்கள் மின்னணு தமிழ் சேவைகள் மின்னனு புத்தக  வடிவமாகி இலவசமாக 

கிடைக்கின்றன.
•	 ஆங்கில எழுத்துகளுக்கு இணையாக தமிழ் எழுத்துக்கள் 30,000 ம�ொழிபெயர்ப்பு செயலி தமிழ் ப�ொறியில் 

இருக்கிறது.
•	 தமிழ் ம�ொழி நிரலில் முதன்மையானது “எழில்” 
•	 உலக ம�ொழிகளை கையாள, தமிழையும் சேர்த்து ஒருங்குறி (Unicode) ஒன்றிணைத்து செய்கின்றது. 
•	 சன்னல் (Windows) தமிழ் சுற்றுச்சுழல் இண்டர்பேஸ் செயல் இறக்கி இணையத்தின் மூலம்  பதிவிறக்கம் செய்து 

நிறுவலாம். 

நினைவில் க�ொள்க
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மதிப்பீடு

பின்வரும் வினாக்களுக்கு விடையளி
1.	 தமிழில் சேவைகளை வழங்கி வரும் தேடுப�ொறிகளை  பட்டியலிடுக
2.	 ஆண்ட்ராய்டு பயன்பாடு விசைப்பலகை என்றால் என்ன?
3.	 தமிழ் நிரலாக்க  ம�ொழி-சிறு குறிப்பு வரைக.
4.	 TSCII என்றால் என்ன?
5.	 தமிழ் இணையக் கல்விக்கழகம்  சிறு குறிப்பு வரைக.

ச�ொற்களஞ்சியம்

ச�ொற்கள் ப�ொருள்

நன்னெறி நன்னெறி ஒரு நபரின் நடத்தையை நிர்வகிக்கும், தார்மீக க�ோட்பாடு ஆகும்.

இணையம் கணிப்பொறி கலாச்சாரத்தின் தன்மை, தகவல் த�ொழில்நுட்பம் மற்றும் மெய் நிகர் உண்மை.

கணிப்பொறி குற்றம் கணிப்பொறி குற்றம் என்பது சைபர் குற்றம்.

நம்பகத்தன்மை உண்மையான அல்லது நம்பகமான தரம்.

குற்றம் புரிபவர் தீங்கிழைக்கும் சட்ட விர�ோதமான அல்லது ஒழுக்க கேடான செயலை செய்பவர்

உரிமையில்லா 
நகலாக்கம் ஒரு நபர் சட்ட விர�ோதமான பதிப்புரிமை மீறுதல்.

ஹேக்கிங் உரிமையாளர் அனுமதி இல்லாமல் கணினி மூலம் அங்கீகரிக்கப்படாத அணுகல்

கிராக்கிங்
சட்டபூர்வமாக பயனர்களுக்கு சேவையை மறுத்து நகலெடுக்கப்பட்ட பாதுகாப்பான 
திட்டத்தை உருவாக்க குறியீட்டை திருடுவது.

தீங்கிழைப்பது வேண்டுமென்றே தீங்கு செய்வது.

இலவச பகிர்வு 
மென்பொருள்

 இலவசமாக கிடைக்கும் ஒரு மென்பொருள்.

பகிர்வு மென்பொருள்
ஒரு குறிப்பிட்ட காலத்திற்கு ஒரு ச�ோதனை அடிப்படையில் இலவசமாக 
விநிய�ோகிக்கப்பட்ட ஒரு மென்பொருள்

ஃபிஷிங்

தீங்கிழைக்கும் தனிநபர் அல்லது தனி நபர்களின் குழுவ�ொன்று மின்னஞ்சலை 
அனுப்புவதன் மூலம் அல்லது தனி நபரின் ஆன்லைன் வங்கி, கிரெடிட் கார்டு அல்லது பிற 
உள் நுழைவு தகவலை சேகரிக்க வடிவமைக்கப்பட்ட வலைதளங்களை உருவாக்குவதற்கு 
பயன்படுகிறது.

குக்கிகள்
இணைய தளங்களை பார்வையிடும் ப�ோது வலை சேவையகங்கள் உங்கள் வலை 
உலவிக்கு அனுப்பும் செய்தி

சேதப்படுத்துதல் சட்ட விர�ோதமான தலையீடு சேதத்தை ஏற்படுத்தும் வகையில் குறுக்கீடு.

நச்சு எதிர்ப்பு ஒரு குறிப்பிட்ட நச்சு நிரலுக்கு எதிர்ப்பு.

ம�ோசடி
பெயரிடப்படாத அல்லது அடையாளம் தெரியாத ம�ோசடி செய்தல் நேர்மையில்லாமல் 
ஏமாற்றுதல் சட்ட விர�ோதமாக நடத்தல்.

ஃபயர்வால்
ஒரு இணையப் பாதுகாப்பு ஆகும். இது முன்னரே தீர்மானிக்கப்பட்ட பாதுகாப்பு விதிகளின் 
அடிப்படையில் உள்வரும், வெளிச்செல்லும் சமிக்ஞைகளை கண்காணித்து கட்டுப்படுத்தும்.

பதிலாள் சேவையகம்
பதிலி சேவையகம் (Proxy Server) என்பது, உள்நிலை வலையமைப்பு மற்றும் இணையம் 
ப�ோன்ற பெரிய அளவிலான வலையமைப்புகளுக்கு நுழைவாயில் ஆகும். புராக்ஸி 
சேவையகம் அதிக செயல்திறன் மற்றும் பாதுகாப்பு வழங்குகிறது.
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செய்முறை நிரல்கள் - கையேடு

கணினி பயன்பாடுகள்செய்முறை 11

விதிமுறைகள்: 

1.	 Writer, Calc  மற்றும் CSS –ல் இருந்து ஒரு செய்முறையும்,  HTML - ல் இருந்து மூன்று 

செய்முறைகளும் மற்றும்    JavaScript - ல் இருந்து நான்கு செய்முறைகளும் செய்முறை 

வகுப்புகளில் பயிற்சி செய்ய வேண்டும்.

2.	 செய்முறை கையேட்டிலிருந்து உள்தேர்வு (internal choice)–வுடன் ஒரு வினாவுக்கு 

விடையளிக்க வேண்டும். 

3.	 மதிப்பெண்கள் பகிர்வு (Distribution of Marks)

I. அகத் தேர்வு மதிப்பீடு (Internal Assessment:)                   5 மதிப்பெண்கள்

செய்முறைப் பதிவேடு (Record Book) 5 மதிப்பெண்கள்

II. புறத் தேர்வு மதிப்பீடு (External Assessment:)                     15 மதிப்பெண்கள்

(a) Writer அல்லதுCalc          – செய்முறை 

       HTML அல்லது CSS  அல்லது JavaScript     – குறிமுறை
10  மதிப்பெண்கள்

(b) வெளியீடு 5 மதிப்பெண்கள்

ம�ொத்தம் 20 மதிப்பெண்கள்

குறிப்பு: 

1.	 HTML, CSS மற்றும் JavaScript    குறிமுறையை Notepad –ல் தட்டச்சு செய்யவேண்டும்.

2.	 HTML, CSS மற்றும் JavaScript    க�ோப்புகளை முறையே .htm, .css மற்றும் .js என்ற நீட்டிப்புடன் 

சேமிக்கவேண்டும். பிறகு Internet Explorer, Google Chrome, Firefox ப�ோன்ற ஏதேனும் ஒரு 

உலாவியை க�ொண்டு திறக்கலாம்.
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ப�ொருளடக்கம்

வ.எண் வினா எண் செய்முறையின் பெயர்

1 CA1
ஒபன் ஆஃபிஸ் ரைட்டர் – விலைப்பட்டியல் 
வடிவூட்டல்   

2 CA2 ஒபன் ஆஃபிஸ்கால்க்  வட்டி கணக்கிடுதல்    

3 CA3 HTML – படிவம் வடிவமைத்தல்

4 CA4 HTML – உயரம் மற்றும் எடை அட்டவணை

5 CA5 HTML – பின்னலான பட்டியல்

6 CA6 CSS – வலைப்பக்கம் வடிவூட்டல்

7 CA7 ஜாவா ஸ்கிரிப்ட் JavaScript – உரை காண்பித்தல் 

8 CA8 ஜாவா ஸ்கிரிப்ட் JavaScript – வாய்பாடு 
அட்டவணை

9 CA9 ஜாவா ஸ்கிரிப்ட் JavaScript –வாரநாட்களை 
எழுத்து வடிவில் காண்பித்தல் 

10 CA10 ஜாவா ஸ்கிரிப்ட் JavaScript –உள்புகுதல் படிவம்
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CA1 – விலைப்பட்டியல் வடிவூட்டல்

CA-1
பின்வரும் விலைப்பட்டியலை ஒபன் ஆஃபிஸ் ரைட்டரில்  தட்டச்சு செய்து, அதில் 
க�ொடுக்கப்பட்டுள்ளவாறு வடிவூட்டல்களை செய்க.

Invoice
SAIRAM MEDICAL STORES

Mobile No      : 9002416000
Mail Address  : sairam@gmail.com

P.B.No: 617
70, New Avadi Road,
Chennai 600 010.

23rd Nov 2017

No: 70/162

M/s.	  Eswari Medical Stores,
	 No: 72, N.S.C. Bose Road, 
	 Puduchery - 6210110

For Sriram Medical Stores

Sales Manager

Quantity (Nos) Particulars Rate Amount
20 Johnson Baby Powder 25 500

10 Nestle Milk Powder 100 1000

5 Wood Wards Gripe Water 70 350

Total
Add: GST @ 3%

Net Payable

•	 அட்டவணையில் Total மற்றும் Net payable-யை கணக்கீடு வாய்பாட்டை (formula) பயன்படுத்தவும்

செய்முறை

	 படிநிலை -1.  ஒபன் ஆஃபிஸ் ரைட்டரை திறந்து  Text document அல்லது 
		  Fil→  New → Text Document என்பதை தேர்வு செய்க
	 படிநிலை 2.  க�ொடுக்கப்பட்டுள்ள படி உரையை  உள்ளீட்டு, வடிவூட்டல் செய்க.

குறிப்பு: உரையை வடிவூட்டல் செய்வதற்கு முன், உரையைத் தேர்ந்தெடுக்க வேண்டும்.

உரை வடிவூட்டல் முறை

Invoice மைய மற்றும் சிகப்பு நிறம் Ctrl + E, வடிவூட்டல் கருவிப்பட்டை 
அல்லது வேறு ஏதேனும் முறையில் font 
color–ல் சிகப்பு நிறத்தை தேர்ந்தெடுத்தல்

Sai Ram Medical Stores மைய மற்றும் நீல நிறம் Ctrl + E, வடிவூட்டல் கருவிப்பட்டை 
அல்லது வேறு ஏதேனும் முறையில் font 
color–ல் நீல நிறத்தை தேர்ந்தெடுத்தல்

Eswari Medical Stores தடிமனாக்குதல் Ctrl + B அல்லது ஏதேனும் ஒரு முறை. 

	 படிநிலை -3 இவற்றில் (4 நெடுவரிசைகள் மற்றும் 7 வரிசைகள்) ஏதேனும் ஒரு முறையை பயன்படுத்தி 4 

நெடுவரிசை மற்றும் 7 வரிசைகளையுடைய  அட்டவணையை உருவாக்குக. Ctrl + F12 அல்லது Insert 
→ Table அல்லது Table → Insert → Table அல்லது  கருவிப்பட்டையில் உள்ள Insert Table icon. 
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	 படிநிலை – 4.  க�ொடுக்கப்பட்ட வடிவமைப்பின் படி தரவை உள்ளிடவும்.

	 படிநிலை -5. 5 வது வரிசையில் முதல் மூன்று நெடுவரிசைகளைத் தேர்ந்தெடுக்கவும்.

	 பிறகு Right Click  → Cell → Merge
	 படிநிலை -6. 7 வது வரிசையில் படிநிலை- 5 ஐ மீண்டும் செய்யவும்.
	 படிநிலை -7. வாய்ப்பாட்டைப் பயன்படுத்தி ம�ொத்தத்தைப் (Total) கணக்கிடுவதற்கு D5-யில் 

=<D2>+<D3>+<D4> என்பதை உள்ளிடுக.
	 படிநிலை -8. 3% GST-யை கணகிட = <B5>* 0.03 என்ற வாய்பாட்டை உள்ளிடுக.

	 படிநிலை -9. வாய்ப்பாட்டைப் பயன்படுத்தி நிகர செலுத்துதலை (Net Payable) கணக்கிடுவதற்கு.

	 D7-ல்  =<D5>+<D6> என்பதை உள்ளிடுக.

வெளியீடு

Invoice
SAIRAM MEDICAL STORES

Mobile No      : 9002416000
Mail Address  : sairam@gmail.com

P.B.No: 617
70, New Avadi Road,
Chennai 600 010.

23rd Nov 2017

No: 70/162

M/s.	  Eswari Medical Stores,
	 No: 72, N.S.C. Bose Road, 
	 Puduchery - 6210110

For Sriram Medical Stores

Sales Manager

Quantity (Nos) Particulars Rate Amount
20 Johnson Baby Powder 25 500

10 Nestle Milk Powder 100 1000

5 Wood Wards Gripe Water 70 350

Total 1850
Add: GST @ 3% 55.5

Net Payable 1905.5

CA2 - வட்டி கணக்கிடுதல்  

CA-2
ஒபன் ஆஃபிஸ்கால்க் -ஐ பயன்படுத்தி பின்வரும் தரவுகளுக்கு வட்டி அறிக்கையை 

உருவாக்கு:

	 சாரா லிமிடெட், ப�ொருட்களை விற்பனை செய்கிறது. அவர்களின் விற்பனை க�ொள்கையின்படி, 
பணம் செலுத்தாத நாட்களுக்கு ஆண்டுக்கு 2%வட்டி வசூலிப்பது.  பின்வரும் தரவிலிருந்து, ஒவ்வொரு 
வாடிக்கையாளரிடமிருந்தும் வசூலிக்கப்படும் த�ொகையை கணக்கிடுக. ஆண்டுக்கு 365 நாட்கள் என 
எடுத்துக்கொள்ளுக.

Customer Sales Date of Sale NO. of days Date of settlement
Tharani 25000 10/04/2017 60
Mahalakshmi 14000 28/05/2017 30
Kumar 28000 14/07/2017 45
Arulmozhi 54000 03/08/2017 90
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செய்முறை

படிநிலை -1. ஒபன் ஆஃபியை திறந்து  Spreadsheet or File → New →Spreadsheet என்பதை தேர்வு 

செய்க.

படிநிலை -2. நுண்ணறை A1 இல்  இருந்து E1 வரை தலைப்புகள் Customer, Sales, Date of Sale, No. of 
days and Date of settlement என்பதை தட்டச்சு செய்யுங்கள்.

படிநிலை -3. நுண்ணறை F1 மற்றும் G1 - ல் Interest Amt மற்றும் Amount to be paid என்பதை   

முறையே தட்டச்சு செய்யுங்கள்.
படிநிலை -4. பணம் செலுத்தவேண்டிய தேதியை Date of settlement அறிய நுண்ணறை E2 இல் = 

C2 + D2 என்ற வாய்ப்பாட்டை உள்ளிடவும்.  மீதமுள்ள நுண்ணறைகள் (E3 முதல் E5 வரை) 
கணக்கிடுவதற்கு Edit → Fill → Down பயன்படுத்தவும்.

படிநிலை -5. வட்டித் த�ொகையை (Interest Amt) கணக்கிடுவதற்கு நுண்ணறை F2 இல் = ROUND 
((B2*2/100)*D2/365) என்ற வாய்ப்பாட்டை. மீதமுள்ள நுண்ணறைகள்  (F3 முதல் F5 வரை) 
கணக்கிடுவதற்கு Edit → Fill → Down பயன்படுத்தவும்.

படிநிலை -6. செலுத்தவேண்டிய த�ொகையை (Amount to be paid) கணக்கிடுவதற்கு நுண்ணறை G2 
இல் = B2 + F2 என்ற வாய்ப்பாட்டை  உள்ளிடவும். மீதமுள்ள நுண்ணறைகள் (G3 முதல் G5 
வரை) கணக்கிடுவதற்கு Edit → Fill → Down பயன்படுத்தவும். 

வெளியீடு

CA3 – படிவம் வடிவமைத்தல்

CA-3 கீழே க�ொடுக்கப்பட்டுள்ள படிவத்தை வடிவமைப்பதற்கு ஒரு HTML நிரலை எழுதவும். 

குறிமுறை

<html>
<head>
<title> User Registration </title>
</head>
<body>
<h1 align = center> Registration Form </h1>
<form id=reg_form  method = post  action = " ">
User Name: <input type = text  name=uname /> <br><br>
Password: <input type = password name=pword1 /> <br><br>
Re-type Password: <input type = password name=pword2 /> <br><br>
Gender: 
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<input type = radio  name=male value="M" /> Male
<input type = radio  name=female  value="F" /> Female
<h2 align=center> Additional Information </h2>
Optional Subject: 
<select name=subj>
	 <option value = CT> Computer Technology
	 <option value = Paint> Painting
	 <option value = SG> Sports and Games
</select>
<br><br/>
<input type  = checkbox  name=mail />  Put me on mail list <br> <br> 
<input type = reset  value=Reset />
<input type = submit  value=Submit /> 
</form>
</body>
</html>

வெளியீடு

CA4 - உயரம் மற்றும் எடை அட்டவணை

CA-4 கிழே க�ொடுக்கப்பட்டுள்ள அட்டவணையை வடிவமைக்க ஒரு HTML நிரலை எழுதுக.

Height and Weight

Name Class Height Weight
Mani XII - G 5'0" 45
Vasu XI - H 5'4" 49
Murali XI - B 5'1" 51
Pallavai XII - D 4'5" 50
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குறிமுறை

<html>
<head>
<title> Height and Weight Table </title>
<head>
<body>
<table border=10>
<caption> Height and Weight </caption>
<tr> 
<th width=40%> Name </th>
<th width=20%> Class </th>
<th width=20%> Height </th>
<th width=20%> Weight </th>
</tr>
<tr> 
<td> Mani	 </td>
<td> XII – G </td>
<td> 5’0” </td>
<td> 45 </td>
</tr>

<tr> 
<td> Vasu </td>
<td> XI – H </td>
<td> 5’4” </td>
<td> 49 </td>
</tr>
<tr> 
<td> Murali </td>
<td> XI – B </td>
<td> 5’1” </td>
<td> 51 </td>
</tr>
<tr> 
<td> Pallavai </td>
<td> XII - D </td>
<td> 4’5” </td>
<td> 50 </td>
</tr>
</table>  
</body>
</html>

வெளியீடு

Height and Weight

Name Class Height Weight
Mani XII - G 5'0" 45
Vasu XI - H 5'4" 49
Murali XI - B 5'1" 51
Pallavai XII - D 4'5" 50

CA5 -பின்னலான பட்டியல் NESTED LIST 

CA-5 ஒரு வலைப்பக்கத்தை உருவாக்கி  அதில் பின்வரும் பட்டியல்களைக் காண்பிப்பதற்கு 
ஒரு HTML நிரலை எழுதவும்:

1. Tamilnadu
a. Chennai
b. Madurai

• Languages
o	 Tamil
o	 Malayalam
o	 Telugu
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2. Andhra Pradesh
a. Amaravathi
b. Vijayawada

• Science
o	  Physics
o	 Chemistry
o	 Zoology

3. Kerala
a. Thiruvananthapuram
b. Cochin

• Humanities
o	  History
o	 Commerce
o	 Economics

குறிமுறை

<html>
<head>
<title> Sets of Lists </title>
</head>
<body>
<OL>
	 <LI> Tamilnadu
		  <OL type=a>
			   <LI> Chennai
			   <LI> Madurai
		  </OL>
	 <LI> Andhra Pradesh
		  <OL type=a>
			   <LI> Amaravathi
			   <LI> Vijayawada
		  </OL>
	 <LI> Kerala
		  <OL type=a>
			   <LI> Thiruvanandhapuram
			   <LI> Cochin
		  </OL>

</OL>
<UL>
	 <LI> Languages
		  <UL type=circle>
			   <LI> Tamil
			   <LI> Malayalam
			   <LI> Telugu
		  </UL>
	 <LI> Science
		  <UL type=circle>
			   <LI> Physics
			   <LI> Chemistry
			   <LI> Zoology
		  </UL>
	 <LI> Humanities
		  <UL type=circle>
			   <LI> History
			   <LI> Commerce
			   <LI> Economics
		  </UL>
</UL>
</body>
</html>

வெளியீடு

1. Tamilnadu
a. Chennai
b. Madurai

2. Andhra Pradesh
a. Amaravathi
b. Vijayawada

3. Kerala
a. Thiruvananthapuram
b. Cochin

• Languages
o	  Tamil
o	  Malayalam
o	  Telugu

• Science
o	   Physics
o	  Chemistry
o	  Zoology

• Humanities
o	   History
o	  Commerce
o	  Economics
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CA6 -  வலைப்பக்கம் வடிவூட்டல்

CA-6 கீழே க�ொடுக்கப்பட்டுள்ள விவரங்களின் படி,CSS ஐ பயன்படுத்தி ஒரு வலைப்பக்கத்தை 
உருவாக்கு.

Tamil
	 Tamil is a Dravidian language predominantly spoken by the Tamil people of India and Sri 
Lanka, and by the Tamil diaspora, Sri Lankan Moors, Burghers, Douglas, and Chindians. Tamil is 
an official language of two countries: Sri Lanka and Singapore. 
	 It has official status in the Indian state of Tamil Nadu and the Indian Union Territory of 
Puducherry. It is used as one of the languages of education in Malaysia, along with English, Malay 
and Mandarin. 
	 Tamil is spoken by significant minorities in the four other South Indian states of Kerala, 
Karnataka, Andhra Pradesh and Telangana and the Union Territory of the Andaman and Nicobar 
Islands. It is one of the 22 scheduled languages of India.

விவரங்கள்

கூறுகள் எழுத்துரு பாணி பத்தி வடிவூட்டல் நிறம்

H1 Arial Black - Center Border 2px solid blue

P1 Century Bold - Red

P2 Bookman Old Style Italic - Blue

P3 Century Gothic - - Green

குறிப்பு: Mystyle.css மற்றும்  CA6.html என்ற இரண்டு க�ோப்புகளை உருவாக்கு 

குறிமுறை-1

Mystyle.css
H1
{
  font-family: "Arial Black";
  text-align:center;
  border : 2px solid blue;
}
P1
{
 font-family: "Century";
 font-style : Bold;
 color : Red;
}
P2
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{
 font-family: "Bookman Old Style";
 font-style : Italic;
 color : Blue;
}
P3
{
 font-family: "Century Gothic";
 color : Green;
}

குறிமுறை-2

CA6.htm
<html>
<head>
<title> Tamil </title>
<link rel="stylesheet" type="text/css" href="mystyle.css">
</head>
<body>
<H1> Tamil </H1>
<P1>
Tamil is a Dravidian language predominantly spoken 
by the Tamil people of India and Sri Lanka, and by the 
Tamil diaspora, Sri Lankan Moors, Burghers, Douglas, 
and Chindians. Tamil is an official language of two countries: 
Sri Lanka and Singapore.
</P1>
<br>
<P2>
It has official status in the Indian state of Tamil Nadu 
and the Indian Union Territory of Puducherry. 
It is used as one of the languages of education in Malaysia, 
along with English, Malay and Mandarin.
</P2>
<br>
<P3>
Tamil is spoken by significant minorities in the four other 
South Indian states of Kerala, Karnataka, Andhra Pradesh 
and Telangana and the Union Territory of the Andaman and 
Nicobar Islands. It is one of the 22 scheduled languages of 
India.
</P3>
</body>
</html>
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வெளியீடு

Tamil
	 Tamil is a Dravidian language predominantly sopken 
by the Tamil people of India and SriLankan Moors, Burghers, 
Douglas, and Chindians. Tamil is an official language of two 
countries: Sri Lanka and Singapore.

	 It has official status in the Indian state of Tamil Nadu 
and the Indian Union Territory of Puducherry. It is used as one 
of the languages of educatiooon in Malaysia, along with English, 
Malay and Mandarin.

	 Tamil is spoken by significant minorities in the four 
other south Indian states of Kerala, Karnataka, Andhra Pradesh 
and Telangana and the Union Territory of the andaman and 
Nicobar Islands. It is one of the 22 scheduled languages of India.

CA7 - உரை காண்பித்தல்

CA-7 பின்வரும் உரையை காட்ட ஜாவாஸ்கிரிப்ட் (JavaScript) ஐ பயன்படுத்தி ஒரு வலைப்பக்கத்தை 
உருவாக்கவும்..

Welcome to JavaScript
State Council of Educational Research and Training (SCERT), 

Tamilnadu, Chennai.

குறிமுறை

<html>
<head>
<title> Display text using JavaScript </title>
</head>
<body align=center>
<p> 
<script>
 document.write ("<h1 align=center>Welcome to JavaScript <br>");
 document.write ("State Council of Educational Research and Training (SCERT),<br>");
 document.write ("Tamilnadu, Chennai. </h1>");
</script>
</p>
</body>
</html>
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வெளியீடு

Welcome to JavaScript

State Council of Educational Research and Training (SCERT),

Tamilnadu, Chennai.

CA8 – வாய்பாடு அட்டவணை

CA-8
வரிசைகள் மற்றும் நெடுவரிசைகளின் எண்ணிக்கையை பெற்று ஒரு பெருக்கல் அட்டவணையை 

காட்ட JavaScript ஐ பயன்படுத்தி ஒரு வலைப்பக்கத்தை உருவாக்கவும்.

குறிமுறை

<html>
<head>
  <title>Multiplication Table</title>
  <script type="text/javascript">
    var rows = prompt("How many rows for your multiplication table?");
    var cols = prompt("How many columns for your multiplication table?");
    if(rows == "" || rows == null)
   		   rows = 10;
    if(cols== "" || cols== null)
   		   cols = 10;
    createTable(rows, cols);
    function createTable(rows, cols)
    {
      var j=1;
 var output ="<table border='1' width='500' cellspacing='0'cellpadding='5'>";
      for(i=1;i<=rows;i++)
      {
    	 output = output + "<tr>";
        while(j<=cols)
        {
  		    output = output + "<td>" + i*j + "</td>";
   		    j = j+1;
   		  }
   		   output = output + "</tr>";
   		   j = 1;
    }
    output = output + "</table>";
    document.write(output);
    }
  </script>
</head>
</html>
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வெளியீடு

1 2 3 4 5 6

2 4 6 8 10 12

3 6 9 12 15 18

4 8 12 16 20 24

5 10 15 20 25 30

6 12 18 24 30 36

7 14 21 28 35 46

8 16 24 32 40 48

9 18 27 36 45 54

10 20 30 40 50 60

11 22 33 44 55 66

12 24 36 48 60 72

CA9 - வாரநாட்களை எழுத்து வடிவில் காண்பித்தல்

CA-9 எண்ணை உள்ளீடாகப் பெற்று,  வார நாட்களை எழுத்து வடிவில் காண்பிக்க ஒரு JavaScript 

நிரலை எழுதவும் (switch பயன்படுத்தவேண்டும்)

குறிமுறை

<html>
<head>
<title> Weekday </title>
<script type="text/javascript">
var n=prompt("Enter a number between 1 and 7");
switch (n)
{
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case (n="1"):
document.write("Sunday");
break;
case (n="2"):
document.write("Monday");
break;
case (n="3"):
document.write("Tuesday");
break;
case (n="4"):
document.write("Wednesday");
break;
case (n="5"):
document.write("Thursday");

break;
case (n="6"):
document.write("Friday");
break;
case (n="7"):
document.write("Saturday");
break;
default:
document.write("Invalid Weekday");
break;
}
</script>
</head>
</html>

வெளியீடு

Thursday
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CA10 - உள்புகுதல் படிவம்

CA-10
பயனர்பெயர், கடவுச்சொல் மற்றும் முகவரி ஆகியவற்றை உள்ளீடாகப் பெற்று அதை 
செல்லுபடியாக்கம் செய்ய JavaScript ஐப் பயன்படுத்தி ஒரு படிவத்தை உருவாக்கவும்.

குறிமுறை

<html>
<head>
<script type="text/javascript">
function sub()
{
if(document.getElementById("t1").value == "")
alert("Please enter your name");
else if(document.getElementById("t2").value == "")
alert("Please enter a password");
else if(document.getElementById("t2").value != document.getElementById("t3").value)
alert("Please enter correct password");
else if(document.getElementById("t4").value == "")
alert("Please enter your address");
else
alert("Form has been submitted");
}
</script>
</head>
<body>
<form>
<p align="center">
User Name:<input type="text" id="t1"><br><br>
Password:<input type="text" id="t2"><br><br>
Confirm Password:<input type="text" id="t3"><br><br>
Address:<textarea rows="2" cols="25" id="t4"></textarea><br><br>
<input type="button" value="Submit" onclick="sub()">
<input type="reset" value="Clear All">
</p>
</form>
</body>
</html>

Computer Application Practical.indd   360 4/21/2020   4:48:31 PM



361

வெளியீடு

நிரல்களுக்கான உள் தேர்வு (Internal Choice)

கே.

எண்.

கேள்வி கே.

எண்.

கேள்வி தெரிவு 

(choice)

CA1 ரைட்டர் – 

விலைப்பட்டியல் 

வடிவூட்டல் 

CA6 CSS – வலைப்பக்கம் 

வடிவூட்டல்

CA1 or 
CA10

CA2 கால்க் – வட்டி 

கணக்கிடுதல்  
CA7 JavaScript – உரை 

காண்பித்தல்

CA2 or CA8

CA3 HTML – படிவம் 

வடிவமைத்தல்

CA8 JavaScript – வாய்பாடு 

அட்டவணை

CA3 or CA9

CA4 HTML – உயரம் 

மற்றும் எடை 

அட்டவணை

CA9 JavaScript – 
வாரநாட்களை 
எழுத்து வடிவில் 

காண்பித்தல்

CA4 or CA6

CA5 HTML – – 
பின்னலான பட்டியல் 
(Nested list)

CA10 JavaScript – 
உள்புகுதல் படிவம்

CA5 or CA7
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கணினி பயன்பாடுகள்  
மேல்நிலை முதலாமாண்டு - ெதாகுதி-1

வல்லுநர்கள், மேலாய்வாளர்கள் மற்றும் நூலாசிரியர்கள் பெயர் பட்டியல்

கலை மற்றும் வடிவமைப்புக் குழு
வடிவமைப்பு
THY டிசைனர்ஸ் & கம்யூட்டர்ஸ், சென்னை..
டேனியல்.அ
In-House - QC
மனோகர் இராதாகிருஷ்ணன் 
ராஜேஷ் தங்கப்பன்
ெஜரால்ட் 
சி. பிரசாந்த்
மதன் ராஜ்

அட்டை வடிவமைப்பு - கதிர் ஆறுமுகம்

ஒருங்கிணைப்பு
ரமேஷ் முனிசாமி

இந்நூல் 80 ஜி.ஸ்.எம். எலிகண்ட் மேப்லித்தோ தாளில் அச்சிடப்பட்டுள்ளது. 
ஆப்செட் முறையில் அச்சிட்டோர்:

பாடப்பொருள் வல்லுநர்கள்
ப�ொ. பாக்கியலட்சுமி
உதவி பேராசிரியர், 
கணினி பயன்பாட்டியல் துறை, இராணி மேரி கல்லூரி, சென்னை.

க. சசிகலா
இணைப் பேராசிரியர், 
கணினி அறிவியல் துறை, இராணி மேரி கல்லூரி, சென்னை.

முனைவர் சித்ரா பாபு
பேராசிரியர் மற்றும் துறைத்தலைவர்,
கணினி அறிவியல் துறை, எஸ்.எஸ்.என். கல்லூரி, சென்னை.

முனைவர் பெ. இராதா
உதவி பேராசிரியர், 
தகவல்  த�ொழில்நுட்பவியல் துறை,
அரசினர் கலை மற்றும் அறிவியல் கல்லூரி, க�ோயம்புத்தூர்.

முனைவர் மெ. நெஸ்டர் ஜெயக்குமார்
இணைப் பேராசிரியர் மற்றும் துறைத்தலைவர்,
கணிப்பொறியியல் துறை, இலய�ோலா கல்லூரி, சென்னை.

முனைவர் நா. சீனிவாசன்
பேராசிரியர், 
கணிப்பொறியியல் துறை, சத்தியபாமா நிகர்நிலை பல்கலைக் கழகம், சென்னை.

முனைவர் பா. சந்திரம�ோகன் 
இணைப் பேராசிரியர், 
கணினி அறிவியல் துறை, VIT, வேலூர்.

இரா. சேதுராமன்
உதவி பேராசிரியர், 
கணினி அறிவியல் துறை, சத்தியபாமா நிகர் நிலை பல்கலைக்கழகம், சென்னை.

க. சங்கர்
உதவி பேராசிரியர், 
கணினி அறிவியல் துறை, RKM விவேகானந்தா கல்லூரி, மைலாப்பூர், சென்னை. 

பாட வல்லுநர்கள்  ஒருங்கிணைப்பாளர்
திரு. இரவிகுமார் ஆறுமுகம்,
துணை இயக்குநர்,	
மாநில கல்வியியல் ஆராய்ச்சி மற்றும் பயிற்சி நிறுவனம், சென்னை.

மேலாய்வாளர்கள்
முனைவர் ரஞ்சனி பார்த்தசாரதி
பேராசிரியர்,  
தகவல் மற்றும் அறிவியல் த�ொழில்நுட்பம், ப�ொறியியல் கல்லூரி,  
அண்ணா பல்கலைகழகம், கிண்டி, சென்னை.

E. முனிவேல்
விஞ்ஞானி/ப�ொறியாளர் ‘C’
தகவல் த�ொழில்நுட்பம் (தகவல்  பாதுகாப்பு), 
NIELI, NIT வளாகம், காலிகட், கேரளா.

நூலாசிரியர்கள்
க. கண்ணன்
முதுகலைப் பட்டதாரி ஆசிரியர், 
சென்னை பெண்கள் மேல்நிலைப் பள்ளி, இராட்லர் தெரு, சென்னை.

வி . க�ோ. இராமகிருஷ்ணன்    
முதுகலைப் பட்டதாரி ஆசிரியர், 
கர்நாடக சங்கா மேல்நிலைப்பள்ளி, தி.நகர், சென்னை.

பிந்து  ம�ோகன்தாஸ்
முதுகலைப் பட்டதாரி ஆசிரியர், 
விஜயந்தா மாதிரி மேல்நிலைப்பள்ளி, எச்.வி.எஃப். எஸ்டேட், ஆவடி, சென்னை.

நு . வீ.  க�ௌரி சங்கர்   
முதுகலைப் பட்டதாரி ஆசிரியர், 
சென்னை பெண்கள் மேல்நிலைப் பள்ளி, நுங்கம்பாக்கம், சென்னை.

இரா.சீனிவாசன் 
முதுகலைப் பட்டதாரி ஆசிரியர், 
சாந்தோம் மேல்நிலைப் பள்ளி, சென்னை. 

க�ோ. லெனின்
முதுகலைப் பட்டதாரி ஆசிரியர், 
சென்னை பெண்கள் மேல்நிலைப்பள்ளி, சைதாப்பேட்டை, சென்னை. 

ஆ. சங்கீதா  
முதுகலைப் பட்டதாரி ஆசிரியர், 
அரசினர் மேல்நிலைப்பள்ளி,  
இராசந்தாங்கல், திருவண்ணாமலை மாவட்டம்.

முனைவர் க.எ. வளர்மதி
முதுகலைப் பட்டதாரி ஆசிரியர்,  
வேலம்மாள் வித்யாஷ்ரம் பள்ளி, சூரப்பட்டு, சென்னை.

இரா. கஜலஷ்மி
முதுகலைப் பட்டதாரி ஆசிரியர், 
ஜெயக�ோபால் கர�ோடிய இந்து வித்யாலயா மேல்நிலைப்பள்ளி,  
மேற்கு மாம்பலம், சென்னை.

முனைவர் ஹ. வித்யா 
முதுகலைப் பட்டதாரி ஆசிரியர், 
டி.ஏ.வி. ஆண்கள் மேல்நிலைப் பள்ளி, க�ோபாலபுரம், சென்னை.

பாடநூல் ஒருங்கிணைப்பாளர்
திரு A. பழனிவேல் ராஜ் 
உதவி பேராசிரியர்,  
மாநில கல்வியியல் ஆராய்ச்சி மற்றும் பயிற்சி நிறுவனம், சென்னை.

திருமதி  நிவேதா செல்வராஜ்  
உதவி பேராசிரியர்,  
மாநில கல்வியியல் ஆராய்ச்சி மற்றும் பயிற்சி நிறுவனம், சென்னை.

திருமதி R. தமிழ்ச்செல்வி
பட்டதாரி ஆசிரியை, 
அரசு உயர் நிலைப் பள்ளி, பூனாம்பாளையம், திருச்சி மாவட்டம்.

XI Std Computer Applications Vol-1 TM Acknowledgement 282.indd   362 4/21/2020   4:48:41 PM


	Chapter 18
	Computer Application Practical
	XI Std Computer Applications Vol-1 TM Acknowledgement 282

